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Table of History - Document and Feature

Date

Retro
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Retro

Retro
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Editions

SG7
1st Edition

SG 8/9
2nd Edition

SG 10
3nd Edition

S$G10.4.8
4™ Edition

$G10.5.6

Descriptions

SG 7 - This guide was created to provide a general reference guide for the DVR Integration to System

Galaxy (SG). This guide provides the general instructions for configuring and operating the SG DVR interface. This guide also

includes SG software requirements and any known DVR requirements that directly impact the SG integration with an individual

DVR (i.e. DVR configuration, and client-side components). Any DVR requirements that do not directly impact the SG integration

are not included in this guide (see your manufacturer’s documentation for requirements and compatibilities related to OS,

install/set up, cameras, codecs, efc).

Galaxy may also offer separate guides to some 3" Party Brand DVR's (i.e. DVTel, Gen. Solutions, RapidEye).

SG 8/9 - this edition includes updates to the DVR integration:

1) Discovery OEM Brand added to DVR Type list in DVR Programming Properties screen.

2) Included instructions for enabling and disabling DVR viewer on a per-PC basis. This allows customer to control whether the
Built-in GCS Video Viewer is available at one workstation vs. another. Defaults to disabled from SG installation.

3) Begin including 3¢ Party DVR client-side requirements in Requirements Section of this guide.

SG 10 - introduces the .NET Framework which opens support to NVRs over several releases of SG-10 :

1) SG System Registration changed: Separated the registration options for OEM and 3t Party DVR.
a) SG allows simultaneous registration for both DVR Support (OEM) and 3P Party DVRs*
« the DVR Type droplist will dynamically include or omit DVR Names based on registration choices.

b) SG supports unlimited number of Galaxy OEM DVRs (i.e. Discovery) in all 3 product levels.
c) SG supports 3 Party DVR registration® in corporate & enterprise levels.
d) When registering 3 Party DVR support, the installer must set the Unit count.

2) The .NET Framework added - allows SG to integrate with NVRs and Embedded models.
Discovery-3 (.NET), Discovery-3 H264, Discovery-3 Embedded Linux OEMs are supported and use the new NVR Viewer.
Also Avigilon, Salient, OnSSI Ocularis v5 were added to the 31 Party list.

3) Importing Camera Names is supported with the NVR and .NET models.

4) Added a concept diagram depicting the hardware linked with cameras for auto-popup of live video.

5) Added a DVR Programming table that lists all supported brands and known default ports.

SG 10.4.8 — Merge all current NVRs/DVRs into this one guide:

1) Merges and updates in this manual to reflect adding newer NVRs and obsoleting older models from content throughout.
2) Specific request for faxable, 1-sheet instructions for any NVR/DVR that requires client-side components.

3) Chapter 1: Updated the System Concept Diagram of the Linked Cameras.

4) Chapter 1: Updated the List of Supported NVRs/DVRs (excluded obsoleted models, include ExacqVision).

5) Chapter 1 Overview: Replaced the Supported Features table with a new split table that breaks-down the Supported Features
for built-in Video Viewers by NVRs vs DVRs Viewers.

6) Chapter 1 Overview & Requirements sections: Updated the NTS Notice to stipulate that DVRs, NVRs, and Embedded VMS
Systems must use the same NTS source as System Galaxy

7) Chapter 2 Configuration: updated DVR Programming Table for Default Port#s and Vendor/Adapter Codes

8) Chapter 2 Configuration: Added separate subsections for NVRs/DVRs that require manual installation of client-side
components (Avigilon, Pelco, OnSSl)

9) Chapter 3 Operation: Added screenshots (with callouts) of GCS NVR Viewer in Live mode and Recorded mode.

$G 10.5.1- UPDATES:
1) minor changes for consistency and update cover release version 10.5.1.

reversioned
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Chapter 1: System Galaxy Overview & Requirements

This guide describes how to register and configure System Galaxy to integrate with compatible DVRs & NVRs; as well as
how to operate the integrated GCS Video Viewer within the System Galaxy software.

The System Galaxy integrated GCS Video Viewer supports playing live and historic video:

» The GCS Video Viewer automatically launches and plays Live Video when triggered by incoming alarms for any
cameras that are linked to a hardware device (inputs, readers, elevator readers, ...).

» The GCS Video Viewer can be manually launched and play Live or Historic Video when the SG Operator invokes the
‘View Video’ command from icons in the SG Hardware Tree or Graphic Screen (camera, reader, inputs ), or from
incoming events and alarms in the SG Events/Alarm screens or from the device activity report.

FIGURE 1 - SYSTEM DIAGRAM: System Galaxy integrated with a Video Management System

System Galaxy VIDEO MANAGEMENT SYSTEM
Access Control System < OEM or 3rd Party >
Event & Video Monitoring Client SG SOFTWARE-LINKED CAMERAS
(lor Communication Server ) FES?XR?C)%SJQTL;I:;\Q\[/)EENOTS PARKING LOT (CAM 1)
DOORS
= - - « Back Door (1) ” FRONT DOOR (CAM 2)
GALAXY 635
= =D i ACCESS CONTROL PANEL ® Front DoOr (2) weeeeeenens
E . e Lobby Door (3) .,
— *+.. LOBBY AREA (CAM 3)
DVR ENABLED — e
GCS VIDEO VIEWER i ':5
—0 Is viewi 7.
UNE & RECORDED Video. INPUTS
for any camera within SG. o Lobby Motion (1)
* MD Hi-Sec. Area
| o INPUT3

ETHERNET NETWORK (LAN)

List of Galaxy OEM and supported 3 Party NVRs / DVRs (VMS)

Galaxy OEM NVR/DVRs 3RD PARTY NVR/DVRs
o Discovery 3 (.NET) e Avigilon
e Discovery 3 Embedded H.264 e ExacqVision
e Discovery 3 Embedded Linux e Honeywell” Fusion
o Discovery 2 e OnSSI Ocularis V5
o Discovery® e Open-Eye" Xseries

e Pelco - DX8-series®

o Salient - CompleteView
e Toshiba” Surveillix

% A separate DVR manual exists for some older models.
(1) NVRs from specified manufacturers are also supported by configuring
the Vendor Codes using the “Discovery-3 .NET” setting.

Some Legacy Models may be discontinued: DVTel Latitude*, General Solutions*, Integral, Kalatel, Loronix, RapidEye*.

Early versions of SG-10 also supported Milestone, NiceVision, OnSSI-V2, Pelco-Endura, which should continue to work after SG-10 upgrade.

SUPPORT: Consult Galaxy Support if you have a DVR/NVR not shown on this list since newer models are continually
E being added to the system.
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Table of Features in the GCS Video Viewers (NVR vs DVR)

VIEWER TYPES CAMERA FUNCTIONS(2) CAMERAL CONTROLS (3) RECORDED VIDEO FUNCTIONS
SUPPORTED FEATURES PTZ FOCUS PRESET TR
AT THE GALAXY VIEWERS .NET GCS IMPORT MULTI-CAM SEARCH .
VIEWER VIEWER NAMES GRID VIEW SPEED + IRIS CLEAR / SET RANGE (PB. CLOCK/RATE)
DISCOVERY-3 (PC-based FOCUS
( ) 1) vES YES YES oreseT onLy | TROM START YES
Also see Embedded & H.264 4X,9X, 16X | INSETTINGS ONLY DATE -TIME  CLOCK (NO SPEED CTL)
Honeywell Fusion YES YES FOCUS FROM START YES
1
Also see Embedded & H.264 (1) YES 4x, 9X, 16X IN SETTINGS ONLY PRESET ONLY DATE - TIME CLOCK (NO SPEED CTL)
Toshiba Surveillix FOCUS
(1) YES YES YES PRESET ONLY | | ROM START YES
Also see Embedded & H.264 4X, 9%, 16X | IN SETTINGS ONLY DATE-TIME  CLOCK (NO SPEED CTL)
OpenEye YES YES FOCUs FROM START YES
1
Also see Embedded & H.264 (1) YES 4X, 9%, 16X | INSETTINGS ONLY PRESETONLY | pate - TiME CLOCK (NO SPEED CTL)
Pelco ** Focus
. . -- YES YES YES PRESET ONLY | | <OM START YES
DX-series / 8-series 4X,9X, 16X | INSETTINGS ONLY DATE—-TIME = CLOCK (NO SPEED CTL)

** pelco models may no longer be supported by later versions of System Galaxy. Contact Technical Support for information.

NOTE (1) Discovery, Honeywell, OpenEye, and Toshiba can use the .NET Viewer by configuring the DVR type to the .NET setting — see below for .NET Viewer features.

PTZ & FOCUS START YES
Galaxy DISCOVERY-3 (Emb.) .NET -- YES -- PRESET ONLY
SLIDER +IRIS DATE - TIME CLOCK & SPEED CTL
PTZ & FOCUS YES
Galaxy DISCOVERY-3 (H.264 ) NET  -- YES -- PRESETONLY | 1ART
SLIDER +IRIS DATE - TIME CLOCK & SPEED CTL
- PTZ & FOCUS YES
Galaxy DISCOVERY-3 (.NET et |- vES . oreseronty | START
Honeywell, Toshiba, OpenEye SLIDER +IRIS DATE - TIME CLOCK & SPEED CTL
.. FOCUS
Avigilon NET . YES . PTZ & PRESET & | START & STOP YES
SLIDER +IRIS CLEAR/SET | DATE-TIME CLOCK & SPEED CTL
. PTZ & FOCUS START YES
ExacqVision .NET -- YES -- PRESET ONLY
SLIDER +IRIS DATE - TIME CLOCK & SPEED CTL
X NET - vES - PTZ- SEE focUs | PRESET ONLY START PLAYBACK CTLS LIMITED
OnSSI Ocularis - v5 (4) : NOTE4 DATE-TIME  NO CLOCK/SPEED CTL
i NET o YES 0T PTZ FOCUS  PRESET ONLY START PLAYBACK CTLS LIMITED
OnSSl Ocularis — v5 Recorder . DATE - TIME CLOCK/SPEED CTL
. . -- -- PTZ & FOCUS YES
Salient ClearView .NET YES PRESET ONLY START
SLIDER +IRIS DATE - TIME CLOCK & SPEED CTL

NOTE 2: Camera Names must be configured at the DVR/NVR unit before you import them into System Galaxy. if camera names appear in Viewer, but do not import into System Galaxy;
reissue the import command while viewer is still open. Sometimes the DVR response exceeds the import timeout. Also the Hardware Tree can be refreshed to ensure names imported by
collapsing and re-opening the Hardware Tree.

NOTE 3: Camera controls like IRIS, PRESETS, PTZ, require the NVR/DVR programming to be configured to support the feature. SG controls are dynamically enabled according to how the camera
is configured at the DVR UNIT. Options are dynamically enabled based on the DVR programming, not the actual camera. If you change or downgrade a camera without changing the DVR
configuration, the buttons may appear enabled but will not work.

NOTE 4: OnSS| Base models support “digital PTZ” which uses the PC Mouse (M1-button) click-n-drag control to perform pan/tilt and click-n-hold to zoom-in, double-click to zoom-out.

GENERAL NOTICES

SYSTEM PRODUCT REGISTRATION:

Galaxy Discovery DVR Support and 3" Party DVR Support are enabled in System Registration according to the purchase agreement.
e  OEM/Discovery DVR Support is available with all product levels (Professional, Corporate, & Enterprise).
e 3 Party DVR Support is available with Corporate and Enterprise levels and you must also configure the Unit Count.

AUTOMATIC LIVE FEED FROM ARMED INPUT/DOOR:
Automated video pop-up requires the camera to be correctly linked to a hardware device and enabling workstation option.

AUTOMATIC LIVE FEED FROM ARMED INPUT/DOOR:
Automated video pop-up requires the camera to be correctly linked to a hardware device and enabling workstation option.

CAMERA CONTROLS & VIDEO CONTROLS IN THE GALAXY VIEWERS:
Video & Camera controls available in Galaxy Viewers are based on the Manufacturer’s Development Kit (SDK). Specific cameral controls such as
PTZ, Iris, etc. are dynamically enabled based upon the camera configuration at the NVR/DVR for each video channel.

MANAGING ASSETS:
See the Manufacturer’s DVR instruction manuals for saving and backing up video assets (historic video files).

NETWORK TIME SYNCHRONIZATION:
System Galaxy is NTS compliant. The DVR/NVR must use the same time-source as System Galaxy. Consult the manufacturer’s instructions for
your DVR/NVR to determine whether the unit can reside on a domain and how to apply time synchronization.
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DVR Compatibility Requirements

This section covers the minimum requirements that apply specifically to the SG DVR Interface in SG-9.

@ System Galaxy’s requirements may not be the same as your DVR/NVR system. Always consult the manufacturer’s

requirements to be sure you meet all the needed specs for your system.

® To prevent security issues you should choose a different, unused port number than the default port number set by the
manufacturer. For your convenience, this guide provides the default port numbers known at the time each DVR was
originally added to the manual (in case you need to get back to the default value). Galaxy never recommends you

permanently use the default port number.

GALAXY CLIENT-SIDE DVR COMPONENT REQUIREMENTS
A few DVRs require a client-side component to be installed on the same PC as the SG Client software. Rapid-Eye is a
brand that requires a DVR client application to be installed.

Most brands, including Discovery DVR, do not require a client-side application to be installed on the Galaxy client
workstation. See the configuration section for details on your model.

» Avigilon* requires a client-side runtime component to be installed on the Galaxy workstation.

» Discovery-3 offers a client-side viewer but this is not required to use the Galaxy Viewer.

» OnSSI Ocularis* requires a client-side runtime component to be installed on the Galaxy workstation.
» Open-eye offers a client-side viewer but this is not required to use the Galaxy Viewer.

» Pelco DX-series* requires a client-side runtime component to be installed on the Galaxy workstation.

* See the related section in Chapter-2 under Adding the DVR / NVR for exact location of the file.

OS & IT REQUIREMENTS

» Network Time Synchronization: The DVR/NVR must use the same NTS time-source as System Galaxy. This
requirement ensures the timestamps on historic/recorded video will match the timestamps of the
corresponding System Galaxy events.

» The SG Server or Workstation PC must have the correct port unblocked used by the DVR/NVR.

» You must meet requirements and best-practice for port, speed, bandwidth, peak demands, and security
when implementing the DVR/NVR interfaces.

GALAXY PRODUCT REGISTRATION REQUIREMENTS

System Galaxy must have the appropriate DVR Support enabled in System Registration before you can add or
connect to DVR/NVRs, import cameras, view live or recorded video, etc.

» Galaxy Discovery/OEM: can be registered under all product levels.

» Brand-Name DVRs can be registered under Corporate or Enterprise levels.

PROFESSIONAL | CORPORATE ENTERPRISE UNIT COUNT
GALAXY OEM DVRS v v v UNLIMITED
BRANDED DVRS -- v v UNIT COUNT MUST

BE REGISTERED
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Chapter 2: Register & Configure the DVR /Cameras

This chapter describes the registration and configuration in System Galaxy.

1--1_-‘
|§"j QUICK STEPS: SETTING UP THE DVR INTERFACE

PART 1. Install DVR Unit and connect and configure all camera (inclu. camera names)
PART 2. Install any Client-side components as appropriate

PART 3. Register System Galaxy for the DVR Support

PART 4. Enable DVR Support in System Settings

PART 5. Configure DVR Alarm Settings as appropriate

PART 6. Add the DVR Unit(s) to System Galaxy with the correct Connection Settings
PART 7. Import Camera Names from the DVR Icon in the SG Hardware Tree

PART 8. Linking hardware to Cameras in System Galaxy

After the initial system programming is completed, the SG Operator can begin using the SG DVR features.

ED‘-'“ SEE: the brand Manufacturer’s DVR Documentation for instructions on how to install and configure the DVR
and camera hardware or client-side components associated with branded DVRs.

EiE L- SEE: the System Galaxy Software Installation Help for instructions on how to install System Galaxy software.
H These installation instructions are found on the HELP module on the CD 1 menu.
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Part-1 & -2 Installing DVR’s Server and Client-Side Software

PART-1 DVR UNIT AND SERVER SOFTWARE:

The DVR unit and any camera configuration should be completed before you try to add it to System Galaxy.

DVR SEE: the brand Manufacturer’s DVR Documentation for instructions on how to install and configure the DVR
and camera hardware or client-side components associated with branded DVRs.

PART-2 DVR CLIENT-SIDE SOFTWARE:

If your DVR also requires client-side software or runtime components, you must install them according to the
manufacturer’s documentation before you can connect to the DVR from System Galaxy.

» Avigilon requires a client-side DXSETUP. exe to be installed on the SG workstation.
[CD Drive SG_Disk2]:\\ DVR Software \ Avigilon \ DirectX \ DXSETUP.exe

Right-click on the filename and Run as Administrator.

» OnSSI Ocularis requires a client-side runtime component to be installed on the Galaxy workstation.
[CD Drive SG_Disk2]:\\ DVR Software \ OnSSI\ OnssiOcularis \ Onssi Ocularis SDK Runtime_5.0.1.105.exe

Right-click on the filename and Run as Administrator.

Discovery-3 offers a client-side viewer but this is not required to use the Galaxy Viewer.
Open-eye offers a client-side viewer but this is not required to use the Galaxy Viewer.

Honeywell / Toshiba may offer a client-side viewer but this is not required for the Galaxy Viewer.

v v v Vv

Pelco Endura requires two client-side runtime components to be manually installed on the Galaxy workstation.
The technician must manually install the directx_aug2009_redist.exe and PelcoAPISDK-1.2.0.-1755.vc9.msi (Disk-2)

Dotnetfx35.exe (.NET Framework v3.5) and the vcredist_x86.exe are automatically installed by System Galaxy

» Pelco DX/8-series offers a client-side module that is not mandatory (SG can connect without it).

The DX IP Security Policy Flag must be configured to allow the SG client PC’s IP Address to be accepted if the client
modaule is not installed. Right-click on the filename and Run as Administrator.

It may be necessary to create an additional DVR Login ID for the SG Viewer to use. Pelco limits the number of connections
allowed under a single Login ID at the Pelco unit.
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Part-3 Registering System Galaxy for DVR Support

DVR Support is registered during the initial System Registration (14-day grace period applies). DVR Support can also
be added to an existing system. A new registration code must be acquired from Galaxy Control Systems when adding
DVR support after initial registration (Certified Dealer required).

Open the Product Registration screen - from menu Configure » Options » Registration » System.
1) Inthe System-Wide Features, you will check the appropriate DVR option to enable it. Unchecked means the
option is disabled.
M OEM Discovery DVR/NVR: check the “Galaxy DVR” option. You do not have to count the DVRs.
M 3" Party DVR/NVR: Check “3™ Party DVRs” and enter the number of units you will install.

NOTE: You can register both branded and OEM in the event the customer has multiple DVRs to be installed or is
adding to an existing system. You do not have to count the OEM/Discovery DVR/NVRs.

2) Complete the normal registration process as needed.

3) Enter the new Registration Code and click [Apply] button, then click [OK] button.
Restart System Galaxy software application after registration is complete.

FIGURE 2 - PRODUCT REGISTRATION SCREEN — DVR SUPPORT OPTION

System Registration
|
Current System 1D: Registered System 1D: Created Date,/Time: Workstation Co
1686864626 1686864626 6/18/2013 12:09:48 PM 1 Enabled the appropriate DVR option.
e e B e Also, set the [DVR limit] to the correct number if
ustomer Name: ONZEs alzdy Lealer IName ., == . . RD
== == ool installing 3RP Party brand of DVR/NVR.
I Product Level:
24 Corporate 5
System-Wide Features: oftware Maintenance Settings: Web Client Options
Expiration Date: . .
[Z]CCTV Cortro P n = [web Cient (457 ol  Enter the correct Registration Code.
[¥] Card Data Import/Export 1A~ [Z] Photo 1D Badge gfin

After you have completed all other settings.

Event Log Output (RS-232/TCEM®/ File) * Requires CardfExd

5G. Time & Attendance
User Status/ Who's |
Galaey DVR
3rd Party DVRs
[¥] Mlarm Panel Support

Guard Tour

Passback & Door Groups

[¥] Graphic Device Status

508 & 50 Support

Biometric Inteface Support
Unlimited Card Capacity (500 only)
Access Rule Ovemide (600 onby)

DWVR Limit:

Maximum Version:

100 ~

Madmum Readers:  # Used:

16 = 10

Maximum Biometric Readers:
0

Maxmum D51-Based Readers:
]

Badge Printing Systffm:
[Card Exchange Ir‘ide v]
Click the APPLY button.
Visit GESCrlihe Web Reqistration Site: m

RegistratioEode:
T2BGFA5]

Last Registered Diate/Time:
10/9/2014 2:51:26 PM

\ 4

3

Apply |

ok || Cancal |

SUPPORT: Dealers may use the GCS Online Registration website 24/7, or contact customer service.
A valid maintenance agreement is required for upgrading systems. Dealer online logon is required.
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Part-4 Enabling & Disabling DVR Support per Workstation

The DVR Enabled option allows owner to enable or disable the DVR Support at each individual workstation through
the Galaxy System Settings screen. You may not want some workstations in the system to be able to start up and
view video from the Galaxy DVR Viewer. This option is ON/enabled by default.

ENABLING DVR SUPPORT AT SG WORKSTATIONS

Open the System Settings screen - from menu Configure » Options » System Settings

1) Place a “check” in the DVR Enabled option - in the General tab.
e Unchecked means the option is disabled

e user will not be able to add a DVR, or Cameras, and cannot view video.
2) Click the APPLY button then OK button to save your changes.

3) Restart the System Galaxy software to initiate the changes. (NOTE: see next section before restarting)

FIGURE 3 — ENABLE DVR SUPPORT IN SYSTEM SETTINGS SCREEN

System Settings - @

| Badging Cptions I CCTV Options I Time & Attendance Cptions I Guard Tour Options I Card Data Replication Options
General Options | Alamm Cptions | Report Options I Multi-Media Cptions I Audit Options I Database Options I Cardholder Options

Event Window Options: Biometric Settings:
(@ Each loop has its own event window Biometric: System:
() All loops share a single evert window

[MorphoManager BioBridge vl

Evert buffer size: 200

Show Hardware Tree on startup || Enable Loop Group Mechanism

Show Communication Control on startup || Enable Schindler Elevator |

Show Events on startup

[7] Photo Veerfication Enabled Device Status Jj
lUze Valid Access Events

DVR Enabled option in the General tab
e checked = enables the DVR/NVR support
e unchecked = disables the DVR/NVR support

milli-seconds

Use Passback Events

[7] Enable Event View Grdlines
Confirm Exit/Close
DVR Enabled
Display Maintenance Expiration Waming Message

0K || Cancel || fppiy |
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Part-5 Automatic Call-up of LIVE Video for Armed Alarms (per Workstation)

You can configure the workstation to automatically show INSTANT LIVE FEED when an armed alarm occurs in the
System Galaxy system. This is enabled by checking the ‘Automatically Call-up DVR Video’ option in System Settings
screen.

IMPORTANT:

» This is a per workstation setting, and will not affect other workstations in the Galaxy system.
» A master operator login is required to edit System Settings (or System Settings) screen.

» The ‘Automatically Call-up DVR Video’ shows video for cameras that are linked to an input or door/reader
that has been configured to need acknowledgement and that are armed.

» Alarm Priority: Be aware that if you if you are using alarm priorities, that the live feed will come from the
camera with the highest priority, not necessarily from the most recent incoming event.

Open the System Settings screen - from menu Configure » Options » System Settings
1) Select the Alarm Options tab.

2) “Check” the ‘Automatically Call-up DVR Video’ option to enable it. (Unchecked means the option is disabled and
the DVR Viewer will not Auto-call LIVE feed for any armed alarms.)

3) Click the APPLY button and OK button to save your changes.

4) Restart the System Galaxy software to initiate the changes.

FIGURE 4 — ENABLE DVR SUPPORT IN SYSTEM SETTINGS SCREEN

-

System Settings
Badaing Options CCTV Options Time & Attendance Options Guard Tour Options Card D
General Options Alarm Options Report Options Multi-Media Options Audit Options [latabase Optic
Min Max
i 1] 5555 [ Pop up on alam
Acknowledge al rity :
L b s B - Allow Acknowledge Al
Force response above priorty: < Allow Delete command
B3 0 [] Treat Mot In System everts as Invalid Attempts
M sponse text | h: - y
bbrrrrabie b =ndt Automatically Delete Acked & Restored Alamms
Color Settings: [] Enable Detection Systems Interface
2 o v| Enable Double-Click Acknowledge
[w] Enable Double-Click Acknowledg
Pending alam message: ’._L| Automatically Call Up OVR Video
Prevent Application Shutdown w/Pending Al
Pending alam baclkground: ’._LI e . P S
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Part-6 Adding an NVR or DVR in System Galaxy

This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

o v ks wnN e

The NVR/DVR unit and all the cameras are correctly installed /configured (including camera names).

The login ID /PASSWORD for SG has been created at the NVR/DVR.

The correct client-side components have been installed if required (Avigilon, OnSSl, Pelco see next pages)

System Galaxy is properly installed & registered for the appropriate DVR (OEM vs 3™ Party).

The System Galaxy DVR ENABLED option is checked in the System Settings Screen/General tab.

Automatically call up Video option is set (checked = ack’d alarms will pop video) System Settings Screen/Alarm tab.

ADDING A DVR (General Instructions)

Open the DVR Programming Screen - from menu Configure » Hardware » DVR’s

1)
2)

3)
4)
5)
6)
7)

8)
9)

Click the [Add] button in the DVR screen to add a DVR.

Enter a unique name for the DVR in the [Name] field (i.e. “DVR Unit 01”). This name will appear in [DVR
droplists] in the Camera Programming screen and in the Reader/Input Programming screens.

Choose a DVR type from the [Type] droplist that matches the type of DVR you will connect to.

The Vendor Code or Adapter Type droplist must be set to a value matches the type of DVR are adding.
Enter the IP address or DNS Name of the DVR Unit.

Enter IP Port Number if it will be different from the default value automatically shown.

Enter the User Name & Password (logon): The login used here must exist at the DVR Unit and does not
necessarily need to be the highest logon, but must allow viewing and controlling video.

Click the [Apply] button to save settings.
Restart System Galaxy software.

FIGURE 5 - DVR PROGRAMMING SCREEN & TABLE

Select a DVFR: s Type DVR/NVR Dflt Port Vendor Codes Viewer
Discovery 3 (NET) Edit Discovery (GCS) 6808 | Normal DVR GCS Viewer
ToeE Discovery 2 9871 Normal DVR GCS Viewer
Marme: 10 Mumber: Discovery 3 * 2000 Normal DVR GCS Viewer
DR #1 (Disc 3 NET) 1 Apply
| — Discovery 3 (.NET) 2000 G3 Embed. H.264 .NET Viewer
DWR Tupe: “Wendor Code: :
..... Honeywell, OpenEye, Toshiba (1) —cari .
[Discovary 3 (NET) i v|  [NomalDVR INDRMALDVR) ~ | 2000  XM3100 (E-series)  .NET Viewer
) ] Discovery 3 Emb. H264 2000 Normal DVR GCS Viewer
Connection Settings: . . =
P Add DNS N P Discovery 3 Emb. Linux 2000 Normal DVR GCS Viewer
ey o Avigilon 38880  Normal DVR {NET Viewer
ExacqVision 22609  Normal DVR .NET Viewer
Security Settings: DVTel Latitude -- Normal DVR GCS Viewer
User Mame: Diva HTTP (2) 80 Normal DVR GCS Viewer
Admin General Solutions (2) -- Normal DVR GCS Viewer
Eesaiiai Confim Password: Honeywell Fusion * 4000 Normal DVR GCS Viewer
xxxxxxxxxxxxxxxx onSS| NetDVMS v2 80 Normal DVR GCS Viewer
Show Password Characters OnSSI Ocularis v5 8080 Normal DVR .NET Viewer
OnSSI Ocularis (.NET) o ze:ED\‘/’;V':dAd:P'e' NET Vi
) el apter o lewer
* Specified models use the GCS Viewer. various models supported (3) OC Adapter
(1) If you have a newer Honeywell, OpenEye, or Toshiba that uses the Open-eye Xseries * 2000 Normal DVR GCS Viewer
§»3 embesided (H.264) or”XM3100(E»Ser|es), then set the D\{R Type Toshiba Surveillix * 2000 Normal DVR GCS Viewer
field to “Discovery-3 .NET” and set the Vendor Code appropriately. sali C leteVi Normal DVR NET Vi
(2) Some DVRs have a separate Guide. alient CompleteView 80 . lewer

(3) For OnSSI Ocularis .NET API select the appropriate Vendor Code.
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ADDING AVIGILON .NET NVR

This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

1. The NVR unit and all the cameras are correctly installed /configured (including camera names).
2. The login ID /PASSWORD for SG has been created at the NVR/DVR.
3. The correct client-side components have been installed if required (see below)
Avigilon requires a client-side DXSETUP. exe to be installed on the SG workstation.
[CD Drive SG_Disk2]:\\ DVR Software \ Avigilon \ DirectX \ DXSETUP.exe

Right-click on the filename and Run as Administrator.

. System Galaxy is properly installed & registered for the 3™ Party DVR and number of units must be set.
5. The System Galaxy DVR ENABLED option is checked in the System Settings Screen/General tab.
6. Automatically call up Video option is set (checked = ack’d alarms will pop video) System Settings Screen/Alarm tab.

Open the DVR Programming Screen - from menu Configure » Hardware » DVR’s
1) Click the [Add] button in the DVR screen to add a DVR.

2) Enter a unique name for the DVR in the [Name] field (i.e. “DVR Unit 01”). This name will appear in [DVR
droplists] in the Camera Programming screen and in the Reader/Input Programming screens.

3) Choose “Avigilon” as the DVR type.

4) The Vendor Code droplist must be set to a value matches the type of NVR being added.

5) Enter the IP address or DNS Name of the DVR Unit.

6) Enter IP Port Number — it should be different from the default value automatically shown.

Type DVR/NVR Dflt Port Vendor Codes Viewer
Avigilon 38880 Normal DVR .NET Viewer

7) Enter the User Name & Password (logon): The login used here must exist at the DVR Unit and does not
necessarily need to be the highest logon, but must allow viewing and controlling video.

8) Click the [Apply] button to save settings.

9) Restart System Galaxy software.

g Use the [edit] and [delete] buttons to change or delete an existing DVR Unit’s configuration.

Page 15 of 46



Galaxy DVR Quick Guide

ADDING ONSSI .NET NVR

This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

1.
2.
3.

The NVR unit and all the cameras are correctly installed /configured (including camera names).

The login ID /PASSWORD for SG has been created at the NVR/DVR.

The correct client-side components have been installed if required (see below)

OnSSI Ocularis requires a client-side runtime component to be installed on the Galaxy workstation.
[CD Drive SG_Disk2]:\\ DVR Software \ OnSSI \ Onssi Ocularis \ Onssi Ocularis SDK Runtime_5.0.1.105.exe

Right-click on the filename and Run as Administrator.

System Galaxy is properly installed & registered for the 3™ Party DVR and number of units must be set.
The System Galaxy DVR ENABLED option is checked in the System Settings Screen/General tab.
Automatically call up Video option is set (checked = ack’d alarms will pop video) System Settings Screen/Alarm tab.

Open the DVR Programming Screen - from menu Configure » Hardware » DVR'’s

1)
2)

3)
4)
5)
6)

7)

8)
9)

Click the [Add] button in the DVR screen to add a DVR.

Enter a unique name for the DVR in the [Name] field (i.e. “DVR Unit 01”). This name will appear in [DVR
droplists] in the Camera Programming screen and in the Reader/Input Programming screens.

Choose “OnSSI OCULARIS .NET” (or appropriate type) as the DVR type.
The Vendor Code droplist must be set to a value matches the type of NVR being added.
Enter the IP address or DNS Name of the DVR Unit.

Enter IP Port Number — it should be different from the default value automatically shown.

Type DVR/NVR Dflt Port Adapter Codes Viewer
OnSSI NetDVMS v2 80 Normal DVR GCS Viewer
OnSSI Ocularis v5 8080 Normal DVR .NET Viewer
OnSSl Ocularis (.NET) NetDVMS Adapter .NET Viewer
various models supported (3) 81 NetEVS Adapter

OC Adapter

Enter the User Name & Password (logon): The login used here must exist at the DVR Unit and does not
necessarily need to be the highest logon, but must allow viewing and controlling video.

Click the [Apply] button to save settings.

Restart System Galaxy software.

g Use the [edit] and [delete] buttons to change or delete an existing DVR Unit’s configuration.
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ADDING PELCO DVR
This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

1.
2.
3.

The DVR unit and all the cameras are correctly installed /configured (including camera names).

The login ID /PASSWORD for SG has been created at the DVR.

The correct client-side components have been installed if required (see below)

Pelco Endura requires two client-side runtime components to be manually installed on the Galaxy workstation.
o directx_aug2009_redist.exe (Disk-2)
e PelcoAPISDK-1.2.0.-1755.vc9.msi (Disk-2)

System Galaxy is properly installed & registered for the 3™ Party DVR and number of units must be set.
The System Galaxy DVR ENABLED option is checked in the System Settings Screen/General tab.
Automatically call up Video option is set (checked = ack’d alarms will pop video) System Settings Screen/Alarm tab.

Open the DVR Programming Screen - from menu Configure » Hardware » DVR’s

1)
2)

3)
4)
5)
6)

7)

8)
9)

Click the [Add] button in the DVR screen to add a DVR.

Enter a unique name for the DVR in the [Name] field (i.e. “DVR Unit 01”). This name will appear in [DVR
droplists] in the Camera Programming screen and in the Reader/Input Programming screens.

Choose the appropriate Pelco model as the DVR type.

The Vendor Code droplist must be set to a value matches the type of DVR/NVR being added.
Enter the IP address or DNS Name of the DVR Unit.

Enter IP Port Number — it should be different from the default value automatically shown.
NOTE: The Pelco Endura and other brands may no longer be supported in Galaxy.

Enter the User Name & Password (logon): The login used here must exist at the DVR Unit and does not
necessarily need to be the highest logon, but must allow viewing and controlling video.

Click the [Apply] button to save settings.
Restart System Galaxy software.

g Use the [edit] and [delete] buttons to change or delete an existing DVR Unit’s configuration.
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Part-7 Importing or Adding Camera Names to System Galaxy

This section describes how to import camera names as well as how to manually add a camera.

On newer integrations, SG will import the camera names, however older DVRs did not support this and the cameras
had to be manually added. If you are manually adding the camera names you must be careful to program the
camera 1 name to match the camera name on channel-1 of the DVR.

IMPORTING CAMERA NAMES
This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

1. The DVR unit and all the cameras are correctly installed /configured (including camera names).
2. You must have added the NVR / DVR unit to System Galaxy (see prior section) and met all the requirements listed.
3. You must be able to connect to the NVR / DVR unit.

Launch System Galaxy and sign-in - the Hardware Tree should be showing the DVR/NVR just added.

1) Click the [+] button to expand the “DVRs” list in the Hardware Tree.
2) Right-click on the NVR/DVR Name in the hardware tree — to open the shortcut menu
3) Choose ‘Import Cameras’ from the menu - the viewer opens and cameras will populate (don’t close viewer) .

0 ]
LT b

126
]
13
126,

a1
201
201
201
a01
W01

= DRy e puca o
B Awigilon :_?:':.5:

Import Camera Harmes ;-\.:, :‘;-.
Properties 2601
sl

4) Refresh the Hardware Tree to see the cameras:

a. HINT: Close the Hardware Tree and reopen it from the SG menu — View P Hardware Tree
5) Now Click the [+] button to expand the “DVRs” list in the Hardware Tree.
6) Now Click the [+] button of the DVR/NVR NAME - to see the imported camera names in the Hardware Tree.

I IF the names are not shown yet, then redo step 2 thru 3 while the viewer is still open. Camera names should populate the
hardware tree. If cameras still don’t import, check your connection settings or manually map/program the camera names.

3 %E:F-:‘D'-I

- EDD 5AM DIEGOD
+ Cortealary
= % Dioorn Ragders

Clustesr: D08, Cont:

S5 00RM DOOR 272

- B mwigilon
Bx Break Room
Exm Break Room 2
X Parking East Lot
EE Parking West Lot
Ex Lobby Entry
EE Stairwell
Bx Conference Rm

7) Now you can start linking cameras to the readers / inputs as desired.
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MANUALLY ADDING CAMERA NAMES

This section assumes you have already taken care of the prerequisites (listed below):

PREREQUISITES

1. The DVR unit and all the cameras are correctly installed /configured (including camera names).
2. You must have added the NVR / DVR unit to System Galaxy (see prior section) and met all the requirements listed.
3. You must be able to connect to the NVR / DVR unit.

Open the Camera Programming Screen - from menu Configure P Hardware » DVR Cameras

1) Click the [Edit] button in the Camera screen to rename a Camera.

2) Select a DVR name from the [Select DVR] droplist that you wish to configure the cameras for.

3) Type a unique name for the Camera in the [Name] field (i.e. “Lobby 01”). This name will appear in [Camera
droplists] in the Reader/Input Programming screens.

4) Click the [Apply] button to save settings. Camera Name will appear in the SG Hardware Tree. Refresh the
hardware tree by re-opening it from the View menu.

FIGURE 6 — CAMERA PROGRAMMING SCREEN

%]
:: EEE l:ﬁEONI){ Select a DWR:
%@ 600 SAN DIEGO | Galay =l
+-[J8 Controllsre
- Jm Doors/Readers Select Camera
Cluster: 008, Cont: 007, | J
S0 DORM DOOR 242
= % ,,l‘l:-:l_“HGS | I arne: Carmera Mumber:
5 Galaoy
e e wlcam 01 PTZ Fioof I 1
Bn Camera 02
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Part-8 Linking Cameras to Hardware in System Galaxy

Cameras can be linked with a Door Reader, Elevator Reader or Input Device.

LINKING A CAMERA TO A READER

Open the Reader Programming Screen - from menu Configure » Hardware » Door/Reader
1) Select the Loop, Control Panel, and Reader you want to link to a camera.
2) Select the ‘DVR Camera Settings’ tab and click [Edit] button.

3) Click EDIT to configure the CAMERA link.
e Select the DVR then Camera you want to link to.
o If the chosen camera is a PTZ and your DVR supports client-side presets (such as Discovery-3)
4) (optional) To cause this device to trigger an alarm condition within System Galaxy, set the M Ack
option to “checked”. This option is in the Alarm Options tab. NOTE: see the section on Auto Calling

Video on Alarm to configure automatic start up GCS DVR Viewer and live video feed plays back. The
highest priority alarm will be displayed.

5) Click [Apply] button to save changes.

NOTES

LINKING MULTIPLE READERS TO A CAMERA: You can link more than one reader to the same camera.

UNLINKING READERS FROM A CAMERA: You can UN-link a camera from a reader by setting the DVR field to
“NONE” or by changing which camera the reader is linked to.

FIGURE 7 — LINK CAMERA TO A DOOR/READER - PROGRAMMING SCREEN

B
ey 600 HO
N en0 PHEOMIX Loop: | _] Cantral Unit: |
[ 60D SAN DIEGOD Clugter; 008, Cont; 001, Brd: 2, Sect: 20
B 3 Motes:
+-[J8 Cnntn:-!lerf' Freader Marme: |SD DORM DOOR 272 ]
- ﬁw Doors/Readers —
B Clusier 002 Cart 001 RsdeType | Froximily [ |
IE S0 DORM DOOR 272 }‘,..4 Wiegand Standard
= % ’;_“__ General TimingdS chedules Relay 2 Settings Alarm Options | Paszhack Avhn's In
= r::.l:.-:-‘.. T CCTV Events Access Rules Elewvator Schedules D%R Camera Settings
BH Cam 01 PTZ Roof }.__‘ - :
B Camers 03 Select DVR: : Select Camera: Preset;
B Camers 04 | Gialasy Cam 01 FTZ Roof ] = [
3
Bm Camerz 05
Bl _Camers 06
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LINKING A CAMERA TO AN INPUT

Open the Input Properties screen - from menu Configure » Hardware » Input Devices

1) Choose the desired Loop, Control Unit and Input Name from drop lists as necessary.
2) Select the ‘DVR Camera Settings’ tab and click [Edit] button.
3) Select the desired DVR and Camera from the drop lists.
4) Set the M Show in Tree option to “checked” to allow the input’s camera option to be selectable from the
short-menu in the SG Hardware Tree.
5) Set the M Acknowledge option to “checked” to allow the input to trigger an alarm if desired. NOTE: that an
alarm condition can be used to automatically start up GCS DVR Viewer and live video feed.
6) Click [Apply] button to save changes, then refresh Hardware Tree (close and re-open) to display the input
icon in the tree. Hardware Tree can be reopened from the View Menu.
NOTES
LINKING MULTIPLE INPUTS TO A CAMERA: You can link more than one Input with a Camera.
UNLINKING READERS FROM A CAMERA: You can UN-link a camera from an input by setting the DVR
field to “NONE” or by changing which camera is linked to the input.
FIGURE 8 — LINK CAMERA TO AN INPUT - PROGRAMMING SCREEN
36
& 500 HG -
600 PHEDNIX Loop: | = |:A
2 I Ap
- WA 600 SAN DIEGO Control Unit | _J
[+ @E Controllers Larl
-l E: Doors/Readers
i Cluster: 008, Cont: 001, Fort Type: Digital [/0 Board [2 [nputs, 4 Outputs) Fepo
% DVRs SR Cluzter: 008, Cont: 0071, Brd: 3, Sect: 2, Inp: 01 Operator Response Instructions:
? LT rr;lah-q. Input Name: IEIuster: 002, Cont: 007, Board: 3. Inp: 1
Bn Cam 01 PTZ Roo :
Bt __‘L_hH ARM Schedule: | =l
Bn Camera 03 a pode: Mormal [nput -
B Camers 04 = -
Tt s v Acknowledge Shaow [0 Tree
BH Camera :E Link to 140 Groups] Optio LTy Events] Graphic Symbols  D%H Camera Seftings ]"Joltage Settings]
Bn Camera 07
Bx Camera 08 Select DYR: Select Camera; Freset:
Bn Camera 09
Gal - { Cam 01 PTZ Roof SRE
B Camers 10 s _] - = I _] |
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VALIDATING CAMERA MAPPING IN SG

After the configuration is complete, you should test the input / reader devices to prove they are correctly mapped to
the corresponding camera and that you can connect to each camera / display video for the area you expect.

Follow the numbered steps to test each device. (The table below assists your verification).

1)
2)
3)
4)

5)
6)
7)

Select the Event Monitoring Screen ( System Galaxy is running and connected to loops)
Open the Hardware Tree and expand the objects to see all inputs and readers.
Induce an event for the device from hardware tree icon (i.e. right-click the icon and pulse / shunt).

Select the resulting event on the Event screen and right-mouse-click to pick the ‘View Live Video’ option from
the short-menu. See Figure-8 in Chapter 3 for an example.

Verify the DVR Viewer opens/displays video for correct area.

Unshunt any input after verification is complete. (inputs only)

Repeat steps 3 through 6 for each device in the list.

Camera Connections Validation List (extra copy in the back — see Appendix A)

DVR NAME: DVR LOCATION:

Device Name/type Camera# ;| Camera Name Location/Area Displayed Check

1

2

10

11

12

13

14

15

16

OO0O00O00oOoo0ooooooo|o
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Chapter 3: Operating the DVR Viewer in SG

Methods of Retrieving Video

You can retrieve (or ‘call up’) video manually or automatically in System Galaxy.

AUTOMATIC VIDEO CALL-UP (ALARM TRIGGERED)

» (Automatic call-up / instant Live Feed) happens when an armed alarm occurs from an input or door that is
linked to a camera (provided the workstation auto call-up option is ON and that device’s ACK option is ON).

MANUAL VIDEO CALL-UP (OPERATOR COMMANDED)
» (Live Feed) Operator calls video from the icon of a camera-linked device (reader/input)
» (Recorded Retrieval) Operator calls historic/recorded video from a status or event message

» (Live or Recorded) Operator calls video for any selected camera from the Viewer when it is already open

The example below shows operator calling video for a door/reader that is linked to a camera.
1) right-click the door or input icon in the Hardware Tree to see the command-menu

2) choose View Live Video option to start live feed for that camera in the GCS DVR Viewer

g Note: some brands such as Avigilon, Salient, or ExacqVision will use the .NET style viewer.

FIGURE 9 — MANUALLY CALL LIVE VIDEO FROM A COMMAND-MENU

SELECT View Live Video
on the COMMAND MENU

RIGHT-CLICK the
DOOR that is
LINKED to a CAMERA

Viewer Opens showing
Live Feed from the
Linked-Camera

(-] Controks Exacq DVR evapi.exacg.com M ; W Topmost
o BRI Y E0 T —

.,
"
,

R b - 00!

DVR Viewer
-
-

lonuaey wooz iy vey @

,

Newer NVR Viewer (.NET)
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Runtime Modes for Galaxy’s DVR Viewer

There are two runtime modes for the GCS DVR Viewer; Normal/Integrated Mode and Standalone Mode.

NORMAL INTEGRATED MODE

The Viewer runs in Integrated Mode when Live or Recorded video is called up from within System Galaxy. Video is
called by either manual operator commands or automatically triggered by armed alarms.

NOTES:

» The View Live Video’ option only displays on command menus from the device icons or event messages
provided the device is linked to a camera.

» Manual and automatic calling video is covered in the previous section of this chapter.

» See chapter 2 for instructions on linking cameras.

STANDALONE MODE ( DIAGNOSTIC ONLY )

The DVR Viewer can operate independently or outside of System Galaxy. This can be done for trouble shooting
purposes. You must supply the connection parameters and logon/password.

basis. See Chapter 2 in this manual for info on enabling/disabling the Viewer at individual

g Blocking Video per Workstation: The GCS DVR Viewer can be disabled on a per workstation
workstations.
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Viewing Modes of the DVR & NVR Viewers

The DVR Viewer has two viewing modes, LIVE and RECORDED.

WHERE VIDEO CALLS FROM... Mm

Automatic call up | from an incoming armed alarm

from SG Hardware Tree YES N/A
» adevice icon

» acameraicon

from SG Graphic Floor plan
» anicon on a floor plan

Operator Selected from DVR Viewer LIVE . YES N/A
» achosen camera (droplist)
from DVR Viewer RECORDED YES N/A

» achosen camera (droplist)

from SG HISTORY REPORT
» historical event

from DVR Viewer’s GRID VIEW N/A YES
» achosen set cameras (droplist)

Operator Selected

Operator Selected

LIVE VIDEO FEED

System Galaxy allows the operator to select live video from a single camera or multiple cameras at once.

NOTES:

= PAN /TILT / ZOOM controls are supported provided the DVR and camera are capable.
= PRESET controls are supported provided DVR and camera supports preset programming.

= Galaxy is Net Time Sync compliant as are the Discovery 3 & selected brand DVRs.

RECORDED VIDEO ( HISTORIC RETRIEVAL )

NOTES:

= See manufacturer’s information for DVR memory limits

= DATE and TIME controls are available to refine your selection

= Split screen or GRID VIEW view is not available in this mode.

= The ‘Playback Controls’ (start, stop, pause, fwd, rew) are available in this mode.

= System Galaxy adds an approximate 30-second lead-time to recorded video. Thus, video retrieval begins
playing at approximately 30 seconds before the requested timestamp.
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DVR Viewer User Interface (PC-based DVR Units)

Buttons and fields are dynamically enabled or disable based on the selected Viewing Mode.

Camera controls are also dynamically enabled or disabled based on the selected camera as well as on how the
camera is configured at the DVR unit.

= Connection settings are available in Live Mode.
= PTZ Control buttons enable in Live Mode if supported™.
= Playback Controls display in Retrieval (recorded) Mode.

DVR VIEWER SHOWN IN LIVE MODE

The figure below shows the DVR Viewer running in LIVE mode. Be aware that some options are available only if the
DVR and camera are capable of supporting the option or control (i.e. Joystick, PTZ, Presets).

FIGURE 10 - GCS DVR VIEWER / LIVE MODE

Pick CAMERA CONNECT or DISCONNECT

Get LIVE
| Connect VIDEO
Live |
3 RETRIEVE
Retrieve RECORDED
5 VIDEO
DVR Setup
| GRID VIEW Set up DVR
Connection
Switch to
GRID VIEW

(multiple live cams)

JOYSTICk *
ZOOM * & FOCUS buttons

Add a Preset *

PAN/TILT *
controls

*PTZ, Joystick & preset features
are enabled only if DVR supports it
via the SDK and camera is capable

Choose a Preset *
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DVR VIEWER SHOWN IN GRID VIEW

The figure below shows the DVR Viewer running in GRID VIEW.

GRID VIEW is only available in live mode.
Several camera sets are available:
» 2x2 (4 cameras showing live feed) choose to see 1 thru 4, 5 thru 8, 9 thru 12, 13 thru 16.

» 3x3 (9 cameras showing live) choose to see 1 thru 9 or 10 thru 16
» 4x4 (16 cameras showing live) this shows 16 cameras simultaneously

FIGURE 11 - DVR GRID VIEW / MULTI-CAMERA LIVE MODE

Grid View ﬁ

Front [PTZ) [FPS 8.9)

k Lot West [FPS 4.6

Camera Name and
Frame Speed is shown

PICK YOUR CAMERA SET UP

Any cameras that are not connected or not operating will not display video.
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DVR VIEWER SHOWN IN HISTORICAL (RECORDED) MODE

The figure below shows the DVR Viewer running in RECORDED MODE.

Galaxy DVR Quick Guide

The availability of recorded or historic video is based on the memory settings and capabilities of the DVR.
This varies by brand. Refer to the DVR manufacturer’s documentations for memory specifications and

instructions on how often to back up your video.

FIGURE 12 - GCS DVR VIEWER / RETRIEVAL MODE ( HISTORICAL/RECORDED )

Pick DATE & TIME
Pick CAMERA

CONNECT or DISCONNECT

Connect

Live
(s |

-
e

[~

Retrieve

DVR Setup

Get LIVE
VIDEO

RETRIEVE
RECORDED
VIDEO

Set up DVR
Connection

GRID VIEW is only available in
LIVE VIDEO MODE
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NVR .NET Viewer User Interface

Buttons, drop lists, and fields are dynamically enabled/disable based on the selected Viewing Mode.

& See the previous section in this chapter for more info on viewing modes.

NOTES:

= User may start Live Mode by selecting it from the SG Camera list in the SG Hardware Tree, as well as from
incoming events and alarms.

= [f selecting or switching cameras from within the Viewer window, user will click the [View Live Mode] button
to initiate the digital feed. SFome model NVRs will switch to the live feed when the camera button is clicked.
Other models require user to select the camera button and then click the view button.

= Use the [show/hide] buttons to reveal or hide the controls as desired.

= PTZ Control buttons are enable in Live Mode if the NVR unit is configured to have a PTZ camera. If the
controls appear enabled but the camera doesn’t move, then the wrong camera is attached or the
configuration is not set up correctly at the NVR unit for that camera/video channel

=  Playback Controls pertain to retrieving Historical Video (Recorded Mode). These may also vary from one
NVR brand to another.

=  GRID VIEW (multi-camera view) is not typically available in this viewer.

NVR .NET VIEWER SHOWN IN LIVE MODE

The figure below shows the NVR Viewer running in LIVE mode. Be aware that certain options are available only if
the brand/model of NVR or Camera are capable of supporting the option (i.e. Joystick, PTZ, Focus, Presets, etc.).

FIGURE 13 - SG .NET VIEWER / LIVE MODE

VIEW LIVE MODE = Show/Hide PTZ Controls

® PTZ Controls automatically display
Show/Hide Playback Contmls—l when a PTZ Camera is selected.
r 5
& Exacq DVR (=] sl
| Dmsennest S Topmost
() 7/15/2015 11:32 an | OQ) mgm NB‘
Show/Hide CAMERAS ———| (<) Pan/Tilt Controls (for camera rotation)
A Cafe 1
- B
- 2
=
H
:
- g Speed Control (for camera rotation)
:
g
L Dogs 2
5 S Preset Orientation & Go®
Choose PTZ CAMERA ET TP G z infout
® Select the [Camera) button — Sony SNC-CS20 O - amera Zoom (infout)
ihen el [Vew Lite Vecel = A Camera Focus (near/far)
I I STt Bame Chanos % Camera Iris (openiclose)*
Pelco IXEIODN
VIDEO WINDOW
The placement and appearance of controls may vary from one brand of recorder to ancther. The availebility of certain features is based on

the brand of camera or recorder you purchased.
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NVR .NET VIEWER SHOWN IN LIVE PTZ MODE
The figure below shows the NVR Viewer running in LIVE MODE.

Certain features such as Iris control or PTZ Preset positions are not available in every brand of
Camera/NVR. NOTE: Presets must be preconfigured at the DVR/NVR unit before they are available in the

Galaxy Viewer.

Also NOTE that the availability of recorded or historic video is based on the memory settings and
capabilities of the DVR/NVR. This varies by brand. Refer to the manufacturer’s documentations for
memory specifications and instructions on how often to back up your video.

FIGURE 14 - GCS NVR VIEWER / RETRIEVAL MODE ( HISTORICAL/RECORDED )

VIEW LIVE MODE - Search for Video by DATE/TIME
ekt ool ke . ~ CONNECT & DISCONNECT

Show/Hide Controls —I

[ Exacq DVR | [ESYESY™>)

Viewer ‘Always on Top’

- PLAYBACK CONTROLS

Show/Hide PTZ Controls

® PTZ Controls automatically display
when a PTZ Camera is selected

Show/Hide CAMERAS

"G Cafe 2
i Door.l
&l Door2
(& Lucky Dogs
3 PS512
o8 Sony SNC-CS20 i Yam - _E<p . | VIDEO FEED DISPLAY

Choose any CAMERA -
® Select the [Camera| button
then click [View Live Mode|
to queue the live video feed

|ONUOY) WOOF i | Ueg °

" - . o ® Window size enlarges when
4 GTest Name Change ! ; . . b g
camera controls are hidden

i Pelco IXELODN

Playback controls include:
= Fast Reverse (at selected speed)
= Reverse (normal speed)
=  Play/Pause toggle button
=  Forward (normal speed)
=  Fast Forward (at selected speed)
= Speed selection droplist (affects FF and FR)

<controls may vary for each 3™ Party NVR>
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Chapter 4: Getting Video with the GCS DVR Viewer
Calling Live Video

There are several ways to get Video from System Galaxy — such as from the Hardware Tree, from the
incoming events, from icons on the

CALL LIVE VIDEO FROM THE HARDWARE TREE

The View Live Video’ option is available on the short-menu when a [Door/Reader icon] or an [Input icon] is selected
from the Hardware Tree in System Galaxy.

1) Right-click on a [Reader Icon] or an [Input Icon] in the SG Hardware Tree that has been linked
to a camera.

» Elevatoricons (red door icon) will behave the same as standard door icon.
» You can also get video from a camera icon in the Hardware Tree.
2) Select the ‘View Live Video’ option from the short-menu: This opens the GCS DVR Viewer and

shows Live Video feed for the camera linked to the device.

IMPORTANT: For trouble shooting tips see Chapter 5.

FIGURE 15 - PLAYBACK FROM AN ICON ON HARDWARE TREE

)8
KRZINO EEEGES) | Connect

Live

lile i AR~
1532005 1.52
Vs 1 5

CORP HO
Retrieve CORF HQ
- CWHg

] CORP H
0 DVR Setup CORP HO

g CORFPHO

Enable = ax Vel r . -
Relay 208 z ' ; GRID VIEW | SRR
3 | CORFHO

CORP HO
CORFP HO
CORPHO
CORPHO

Pulse

Reports »

T
150 72005

CORP HO
173072005 1 Fepan

I‘l"f_, i G . .

- - - S alaxy DVR Viewer opens in
Right-click the device and choose |11 LIVE M(:’;DE forselectzgecamem
View DVR Live Video o

Q0% 1 LLRF WY
1S5 115 CORPHO
R S 1 1205 115 CORPHO
% [ Aarm Panels Iri'w:cmns C:jRDrTE:
(il AR CORFHA
1SS 1% CORPHO
17205 115 CORP HO
1NS20065 115 CORP HO
1.‘31;’_1.‘!:& 112 Cﬁl—h’-’H&

4 DVR Viewer shown (same steps apply to NVR Viewer)
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CALL LIVE VIDEO FROM THE DEVICE STATUS SCREEN
The “View Live Video’ option is available on the short-menu from a Device Status item:

Open the Device Status window from the menu View » Device Status

1) select the desired ‘Status Group’ with the desired readers and inputs included (or add/edit a Status Group as
needed). Click [OK] to open the Device Status screen.

2) Right-click a [Device Status icon/item] linked to a camera to get the short-menu.

3) Select the ‘View Live Video’ option from the short-menu: This opens the GCS DVR Viewer and shows Live
Video feed.

IMPORTANT: For trouble shooting tips see Chapter 5.

FIGURE 16 - PLAYBACK FROM A DEVICE STATUS

Ly - Master Event Window

= B CORFHO
. Contsolery
= B DocraMiastens
L1 P1 - COMPUTER BT |
L1 P2 TECHS
L1 P} FIRE DOOR L ez
L1 P4« PLANT ;
L1 PS SALES DPT ; i —

DVR Setup | |

| GRID VIEW

Right-click the device and choose
View DVR Live Video

Galaxy DVR Viewer opens in
LIVE MQDE for selected camera

4 DVR Viewer shown (same steps apply to NVR Viewer)
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CALL LIVE VIDEO FROM AN EVENT

The “View Live Video’ option is available on the event item’s short-menu in the Loop Monitoring screen.
The Loop Monitoring screen and the Alarm Event screen are opened by default when System Galaxy is
started running. The screens show active logging of events and alarms depending on configuration of
readers and alarm priority settings, and other workstation options.

1) From the Event screen, right-click an Event which is linked to a camera to get the short-menu.

2) Select the ‘View Live Video’ option from the short-menu: The DVR Viewer opens and shows Live Video feed.

IMPORTANT: For trouble shooting tips see Chapter 5.

FIGURE 17 - PLAYBACK FROM LOOP MONITOR EVENT SCREEN

B CEOWR Viewe 83
FroeeDor m} Connact
L1 P COMPUTER AT | | b - Live
L1 P2 TECHS 3
b Retrieve
L1 P4 - PLANT :
L1 PS SALES DPT i e o R ! : : F
L1 P - ANANCE PANESTIEAM  FIA Pot ¢ Folay 208 ! s = DVR Satup
b iren '1-yi-i;l;=3ue;a; ;rm IF‘aI i  Repons » E L= "
Ay trout Devcs SATEe T (AR Pt GRID VIEW
i) PR_Pot 8.0 01 GANSRTHEAM PR Peg {, POpSlNE =
= @WGW F XE ¥ 2w Live Vid
- 2RI FIRL Port. . Trowk
¥ Outpus Devces 2o AR Pot B et 1
O ALARM, Port §, Output PIB, Pest: B, Inat 01

]
1037152006 1529 PM ALARM, Pt 8, Outpet O

Right-click the event and choose
View DVR Live Video

12006 1 4804 P L1 P2 TECHS Ve Ay
1205 14755 P L1 P - COMPUTER ROOM  Valid Aci
/205 14754 P L1 P - COMPUTER ROOM Do Tl
1/1/2005 12800 FPM Can D0 506 10 Girowi

Galaxy DVR Viewer opens in
LIVE MQDE for selected camera

1261632 PM L1 P2- TECHS Mid bn 54
1FG 55T PM (L1 PS SALES DFT st
1208 11555 PM L1 P FIRE DOOA

177152006 11543 Pl FIFL Paet: B inpos OF
al

4. DVR Viewer shown (same steps apply to NVR Viewer)
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CALL LIVE VIDEO FROM AN ARMED ALARM EVENT

Viewing live video is available from the Alarm screen. There are several ways to see video from this screen.

a) Automatic Call-up: The GCS DVR Viewer automatically opens when an armed alarm comes in for a device
that is linked to a camera (if the Automatic Call-up Video) is enabled in System Settings.

P The GCS DVR Viewer shows live video feed for the priority alarm when the alarm device is in the
“ARMED” condition. Thus, if more than one device is in the alarm state, and priorities are used, the
video comes from the device with highest priority

» If a device becomes activated in the unarmed condition, the DVR Viewer will not automatically start up.

b) Manual Call-up: Operators can right-click an Alarm Event from the Alarm events List. Select the ‘View Live
Video’ option from the short-menu.

FIGURE 18 - PLAYBACK FROM ALARM SCREEN WITH ALARMS

1 File

= B coRPHO ----——--—--—-—'-—-.- ;
" Corodens {
= DocnnPiasders

L1 P2 TEOHS -
L1 P3 ARE DOOR i Retrieve
LY PL - PLANT ! - ) .
t: :.&I{ES 0Pt B | = DVR Setup
1P7 h s r
! &F‘OMP‘:‘ | e . = : ) . GRID VIEW
PR_Pot B, - & H ] i o} 5
W LD Goaougs
%P Germes i1
= @ Dupud Devices
Q aLarM Pot B Oupt

Right-click the event and choose ,_._..f\ . -

View DVR Live Video

ns

Galaxy DVR Viewer opens in
LIVE MQDE for selected camera

A PC-Based Viewer shown (same steps apply to NVR Viewer)
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GET LIVE VIDEO FROM THE GRAPHICS SCREEN

The ‘View Live Video’ option is available on the short-menu from the Graphics screen:

1) From the SG menu, select View>Graphics and right-click a Door or Input icon of a device that has been
linked to a camera to get the short-menu.

2) Select the ‘View Live Video’ option from the short-menu: The GCS DVR Viewer opens and shows video feed
with Real-Time clocking/time stamp.

Remember that the clocks on the System Galaxy PC’s and the DVR unit should be synchronized to a common master
clock source for accurate clocking/time stamping.

FIGURE 19 - PLAYBACK FROM GRAPHICS SCREEN WITH DOOR AND INPUT ICONS

! Fle Configure Record Edet

=

g ?mﬁm l S | e Connect
B Dann/Pisden | ¢
LY 1 COMPUTER B Live
L1 P2 TEOHS
L1 P} RAE OO0R e M Retrieve
L1 P4 - PLANT - . -
t::_ﬂii 0FT B ] _-"| DVR Setup

LY P7 pund
= A e Do

GRID VIEW
A\ PR Pot & lrcd 0 ==

Right-click the device icon and
choose View DVR Live Video

I’
|
e

Galaxy DVR Viewer opens in
LIVE MODE for selected camera

4 PC-Based Viewer shown (same steps apply to NVR Viewer)
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Getting Recorded Video from Activity History Report Screen

System Galaxy allows operator to get recorded video from the Activity History Report screen. A digital video clip can
be started from the Report screen by right clicking the message line on the Report screen and selecting the ‘View
DVR Video. The following pictures /instructions illustrate the abbreviated steps to open the DVR Report screen.

To open the DVR report screen, user must setup an Activity History Report and include the desired selections
(events) as appropriate.

1) From the main SG menu, select View P Reports P Activity History
The Activity History Report Selections screen will open.

FIGURE 20 - SG MENU PATH TO VIEW>REPORTS>ACTIVITY HISTORY

B Syilem Galazy - [Mazber Event Wandows]

— = 5
J.'_aﬂﬁmﬁﬂﬂﬂﬁﬂ‘jﬁlﬂlﬂilwm =181 x|
B {'Iﬂ’h IR Y
L L o m —
Handwae Ties > 2
Hadmae T ron /Pt | Evert | Use | Leap =
D“.E..im (000, Cont: Q000 Prost .-:.‘-'neuc Ee-:ue CORPMD
L1P1 - COMPUTER RC E’H s : - : CORF HO -
L1 F2 - TELHS = . " ap i,
L1 F3 FIRE 0O Loap Disgreostics Lrystal Reposts CHEEHD
L1 P4 - Uzes St Awho's In Fiem Archive Database -
L1FS RALES DFT Videao Venifscation 'n The Closck EiL j
H ﬁ.:'l’:l:’l& Guard Tour Hasdwain 5ummaiy CaRF ._::;'
- ‘ Irpadt Diervicas URL Card Tour CORP MO
A Locg: 000, Cont- 000, P ) 110 Group Ammred - Soteeduls CORPHO
<% 10 G V805 1165 M - paned .

OUser selects View Menu
®Then Report
© Then Activity History in System Galaxy

<< continue to next page for instructions >>
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Once the Report Selections screen is open, user must choose the desired events by checking the appropriate options
to specify which activities (events) to include.

2) Select the desired loop and the devices to select by on the left side of desired tabs.
3) Click (check) the events to include in the ‘Reader/Door’ tab from the ‘Specify activities to include’ group of
check-boxes.

4) Click (check) the events to include in the ‘Input Devices’ tab from the ‘Specify activities to include’ group of
check-boxes.

5) Click (check) the DVR View check-box on the bottom right corner of the Report Selections screen.

6) Click [View Report] button to open the DVR Report screen in the System Galaxy window.

FIGURE 21 - ACTIVITY HISTORY REPORT SELECTIONS SCREEN

Activity History Report Selections

Select a loop: Report Profiles:
[corP HO ] =]
Caid/Employee  Fieader/Door | Input Devices | Oulput Devices | Controters |
— Specify doorsfreaders toinclude: ————————————————— [ Specily activities to include:
Telecl doors/readers b J " F Open % Relay2
Specific D -
i ¥ Open Too Long ¥ Delayed Unlock
Select a doot/reader. % NotIn System P Pused
[L1P1 - COMPUTER RODM |
v Scheduled Unlock ¥ Unlocked
¥ Scheduled Lock ¥ Locked

After choosing desired readers and inputs and setting up desired options,
the user must check the DVR View checkbox

ands
Show Selections ¥ Contact Shunted Select &l |  Clear 1 |
Stait Report at: — Stop Repoart at: i /
[ | 17 172004 j |12;m_33m = | 1/20/2005 j | 1319 = Cancel |
Report all events using the specified Daily Report Option - Only include activities that
rtineﬁane r occured between the start and stop times for each day. [ DVR View

<< continue to next page for instructions >>
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Once the SG DVR Report screen is open, user may start recorded video for certain events where device
(reader/door/input) is linked to a camera/DVR Unit. Choose the desired events by checking the appropriate options
to specify which activities (events) to include.

7) Right-click the desired event (line item) on the DVR Report screen.
8) Select the short-menu option to ‘View DVR Video”.
9) The GCS DVR Viewer will open and start video from 30 seconds prior to the event’s timestamp.

Remember that the system clocks on both the [System Galaxy PC’s] and the [physical DVR Unit]
should be synchronized to the same master clock source for accurate clocking/time stamping
and synchronization between the System Galaxy device and the video stream.

FIGURE 22 — RECORDED PLAYBACK FROM THE DVR REPORT SCREEN

= Syatem Galagy - [DVH Repodt)
]_aﬂunmﬁnnumzﬂrhuﬁinmu-

E] —
BN CoRFHO Dt Tirme DrerviceFort
- C orisole HANEIOTLSAM .
1 f R : et PV | 27 LI e, Wi DV Widna COMPUTER ROOM

™ COMPUTER ROOM
PR, Pait: 8. Irgat 01

T2 00K 645 33 2M

2P & 45T AM L1 Pl - COMPUTER ROOM
" L1 PS SALES DPT LA B 7134 A AR, Port 8, Inpat 01
L1 P« FIMANCE SRS B IHE..:-! AR P": 8 I|¢.|r|_.1.
LT P g 2272005 B 3308 M FIL. Poet 8, Ingut 01
= l Ingad Dt W F et 171
A PR Pot B gt 00 IR0 B 3306 AM FIF, Part: 8, Ingut 00
= B 170 Geoups: FAe7r M FIA. Pot: 8, Ir 1
BN Gerewsl 10 0 006 B 31015 AM FiRl, Port: 8, Input 01
=¥ DM”DH"“ Oupul 27202006 33311 PM FIRL Pt 8 Ingut 01

A . !

v - Pot B, A0S 3208 P FIA. Poit B, Imgak 01

223006 3 1304 P
173142005 1:52. 38 FM
1537/ 2008 1:5232 PM

PR, Port 8, Input 1
L1 1 - COMPUTER ROOM
L1 P1 - COMPUTER ROOM

L1 P1 - COMPUTER ROOM
13142005 1.47 56 P L1 FA - COMPUTER ROOM
1312005 1:47 54 FM L1 P! - COMPUTER: ROOM
112005 1 24 00 M Cary 0 S0

112006 15213 P

1731/2005 1:15 i.‘jr“\rl

1315008 1:1 545 P

FiR, Port 8, Input 01

FIF, Pet: £, Ingat O

1732005 1:15 iam FIA, Port 8, Imput 01

O Right-mouse-click the selects event that is linked to a camera
®Then select the View DVR Video option on the short-menu

©The Viewer opens and plays live video session for the camera linked to
that reader/input device.
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Chapter 5 ~ Troubleshooting Tips

Calling video for the wrong cameralarea

1.

4,

Check that the correct camera is linked to the device in the SG software screens (revisit Section 2.6
about linking readers and input devices to cameras). If the device-to-camera mapping appears to be
correct, then check the physical connections between the cameras and DVR — either swap your
physical camera connections or rename your cameras in System Galaxy Programming screen (section
2.5.2).

Check that the camera name in SG is correctly programmed to the desired Camera ID number. If the
device-to-camera mapping appears to be correct, then check the physical connections between the
cameras and DVR - either swap your physical camera connections or rename your cameras in System
Galaxy Programming screen (section 2.5.2).

Check that the camera is physically installed in the position expected and the cable is physically
connected to the camera and to the DVR Unit to the video port intended for the desired area. Correctly
connect the cameras at the DVR Unit.

Restart System Galaxy after programming changes or to ensure previous changes were initialized.

‘DVR Settings’ tab not available in Door/Input screen

1.
2.
3.

Verify that the DVR Support System Registration is complete and valid (not expired). Section 2.4.
Verify that the DVR Enabled option is set correctly. See Section 4.1 for instructions.
Verify that the correct DVR Type is set in the DVR programming screen (Section 2.5.1).

‘View Video’ option not displayed in SG short-menus

© kw2

7.

Verify that the DVR Support System Registration is complete and valid (not expired). Section 2.4.
Verify that the DVR Enabled option is ON in Client Gateway. See Section 2.4.2.
Verify that the DVR BLOCKING is not enabled section 4.1

Verify that the correct DVR Type is set in the DVR programming screen (Section 2.5.1).
Check that the reader/input device is correctly linked to a camera (Section 2.6).

Verify that incoming events are time-stamped later than the time of the camera linking in SG Camera
Programming screen. Events that came in from that device before the linking will not have the option to
view video. User may wish to restart/re-open the target screen (i.e. Hardware Tree, Event Screen,
Device Status Screen, Graphic screen or DVR Report screen) to reset software. Also user can restart
System Galaxy.

Note: video cannot be initiated or retrieved for messages, alarms or graphics that occurred before the
camera is linked to the device. Once the camera is linked, messages from that point on can be use to
initiate video streaming.

Restart System Galaxy after programming changes or to ensure previous changes were initialized.

‘View Video’ option not displayed in Graphics Screen

1.
2.

Check that the target device is correctly linked to a camera. See Section 2.6 for instructions.

Remove and re-add the graphic icon on the Graphic screen to begin seeing the video linking option.
(The device must be linked to the camera and saved to the database before it is added to a Graphic
Screen. You may have added the graphic icon before it was linked or updated in the database.).

Restart the Graphic Screen and/or restart System Galaxy to pick up change if necessary.
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“DVR NAME” not in DVR Type droplist (Adding a DVR)

1. Verify that the correct option “DVR Support” is checked in the SG Product Registration screen. Contact
Galaxy Control System as appropriate for information on or changes to your registration.
2. Check the DVR Enabled option is set correctly (Section 4.1) at the workstation in question.

“DVR NAME” Name is not on the GCS DVR Viewer

1. Verify that the correct option “DVR Support” is checked in the SG Product Registration screen.
2. Verify that other DVR options are NOT checked (i.e. RapidEye, Loronix, Integral, etc) Section 2.4.
3. Restart SG after correcting Registration.

GCS Viewer opens but does not display video

1.

Open the GCS DVR Viewer in Standalone Mode (Section 3.1.1); click the [Settings] button and
enter the correct IP Address, port number (6808) and login parameters; select desired camera and
live mode.
a. If you can get video in standalone mode then check the following:
= Check that System Galaxy DVR Programming screen has the correct network IP Address,
login and passwords are correct and entered into the appropriate fields (section 2.5.1)
= Check that SG DVR Programming screen has the IP Port number set to 6808 (section 2.5.1)
= Check the DVR Enabled option is set correctly (section 4.1) and registration is current.
b. If you cannot get video in standalone mode then see Section 5.8

Cannot get Video in Standalone Mode

1.

Check that you can ping the DVR Unit from the System Galaxy PC. See Appendix B for
instructions on pinging from System Galaxy PC.

a. If you can ping go to step 2 in this section to telnet the DVR’s listening port.

b. If you cannot ping the DVR Unit go to step 3 in this section.

Check that you can telnet to your intended port from System Galaxy. See Appendix C or D
for instructions on Telnet from System Galaxy PC.

a. If you can telnet port go to step 4 in this section.

b. If you cannot telnet port number go to step 3 in this section.

Check that the DVR Unit is powered up and running ( software program is running).

a. You might consider restarting the DVR Unit and software after you make sure that the IP
Address of the DVR is STATIC and not dynamically obtained. Dynamically obtained IP
Addressing will require you to update all the IP Address settings at the System Galaxy PC’s
every time a power interrupt occurs at the DVR. See the setup/configuration screen at the
DVR Software to set this to a Static Address. An IT Professional can obtain a static Address.

b. Enlist the help of your IT Professional if needed to verify routing/switching between System
Galaxy PC/Workstations ant the DVR Unit.

Check that the IP_Address and Port ID at System Galaxy’s software match the DVR’s
settings. Run the “ipconfig” command at the DOS prompt on the DVR Unit and confirm the IP
Address at the DVR. Then verify that SG programming matches. (Set the SG Programming to
match the IP Address of the DVR Unit. See Sections 2.2 and 2.5.1 for instructions on SG.

IMPORTANT: The software must be running. Note that the DVR has an option to control
whether the DVR Unit’s IP Address is static or dynamically assigned. It is recommended that
the DVR IP ADDRESS is set to be static (always the same).
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GCS DVR Viewer is not popping/starting on Alarms

If the GCS DVR Viewer is not popping up when an alarm occurs, user should verify the following things:

1.

Confirm that the ‘DVR Support Enabled’ checkbox is checked in the GCS Client Gateway Service.
See Section 2.4.2

. Confirm that the ‘Automatically Call Up DVR Video’ option is checked in the System

Settings/Alarm Options tab. (User may need to restart the SG Software Application for changes to
System Settings to take effect).

3. Confirm that the PC/Workstation is not “blocked” from Viewing (see section 4.1)

. Confirm that the device (reader/input/motion detector/etc.) is configured to require

acknowledgement. This is done by opening the Properties Screen of the Device via the Hardware
Menu or Hardware Tree. The ‘ack’ checkbox should be checked if an alarm event is desired.

. Confirm whether an Alarm Priority has been configured in System Settings/Alarm Options tab:

a. if a priority range is set to anything other than 0-9999 then user must verify whether the device
in question has been given a priority number that is within the programmed range.

» If a device has no priority value configured, it will not throw an alarm event

» If a device has a priority value that is not equal to or within the min and max values of the
range set in System Settings, then the video will not pop.

» If a device is within the programmed priority range but is a lower priority than another active
device, then the Viewer will display the video from the device with the highest-
unacknowledged alarm event.

» If the device is not armed, then the Viewer will not pop.

. Confirm that the device is linked to a functioning camera — the linking of camera’s to a device is

found in Section 2.7. If the software configuration is correct, consider investigating physical
wiring/connections to the DVR unit and to the actual camera.

. Confirm that the device is in the “Armed/Alarm state. If a device is not armed, then the Viewer will

not pop when the device is active.

GENERAL NOTE: Certain Alarm Options (i.e. Alarm Priority Range and ‘Automatically Call Up DVR Video’) are
configured in the Alarm Options tab, which is located in Workstations Options Screen. This means that the feature
is configured on a “per workstation” basis.

» To open the System Settings screen go to the main System Galaxy menu and select
Configure>Options>System Settings, then select the Alarm Options tab.
Set the desired configuration and click [Apply] button
The System Galaxy software must be restarted for changes to take effect
Alarm Option programming is described in this manual in Section 4.1.2 and in detail in the main
Software Manual for System Galaxy.

SG 7 NOTE: ‘DVR Support Enabled’ checkbox must be “ON” in Client Gateway to support menu options and DVR
Viewer popping .(see Section 2.4.2 for instructions).
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Appendix A: Camera Validation List

Additional Camera Mapping Validation check list - photocopy as needed.

Galaxy DVR Quick Guide

Table 1 System Galaxy Camera Mapping Validation check list

DVR NAME:

DVR LOCATION:

Device Name/type
(Front Door / reader)

Camera #

(1)

Camera Name
( Lobby Cam )

Location/Area Displayed
(Front Door and Lobby Area)

Check
Good

1

10

11

12

13

14

15

16

O o o o o0 o0 0o o o o0 o0 o0 o g O
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To ping a DVR Unit from the command prompt at the System Galaxy PC/Workstation do the following.

Wy windows Update

i H 7| x
Open a Command Window: ) Wiz 2lx
1. Click [Sta rt] button on the -::~*'| Progrars » | Tvpe the name of a pragram, folder, dacument, or
j = i Internet resource, and Windows will open it For you.
Windows® Task Bar j Documents 4
B Settings » Open: |cmd j
. 5 h »
2. Select the ‘Run’ option & Seare
OF Cancel | Browse, .. |

3. Type “cmd” in the field
provided.

4. Click [OK] button

To ping: Once the Command Window opens, type the ping command with the target (DVR) IP Address.
See figure below. Syntax is important, so type one space between command and IP Address.
Type “ping nn.nnn.nnn.nnn”; where “n” stands for the numeric characters in the IP Address

Example 1 shows a reply. Example 2 shows that the target IP Address is not able to reply.

Example 1 — Ping with Reply — good connection
C:A\WINNT\system32\cmd. exe
C:wWINNT“Profilesscroberts>ping 61.111.148.138
Pinging 61.111.148_.13@ with 32 hytes of data:

Reply from 61.111.148.138:- hytes=32 time=18mz TTL=128

Reply from 61.111.148.138: hytes=32 time<iBmz TTL=128
Reply from 61.111.148.138: hytez=32 time<iBms TTL=128
Reply from 61.111.148.138: hytez=32 time<iBms TTL=128

Ping statistics for 61.111.148.136:

Packet=s: Sent = 4. Received = 4, Lost = @ {(Bx loss),
Approximate round trip times in milli-—seconds:

Minimum = Bms, Maximum = 1B8ms,. Average = 2ns

Example 2 — Example Ping with Request Tim

e U 1

e Out — failed to connect

C:WINNT“Profilesscrobert=>ping 61.111.148.13A
61.111.148.138 with 32 bytesz of data:

timed out.
timed out.
timed out.
timed out.

Ping statistics for 61.111.148.138:

Packets: Sent = 4. Received = B, Lost = 4 <{10808x loss>.
Approximate round trip times in milli-—seconds:

Minimum = Umz, Maximum = Bmz, Average = Bms
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Appendix C: Telnet DVR Port ID via Command Prompt

To telnet DVR Unit from the System Galaxy PC/Workstation you can run from the CMD command line.

. wdind, Updat
Open a Command Window: R Windaws Updaie 2x
@ WinZip
1. Click [Start] button on the 2 oarams , Type the name of a program, Folder, document, or
ind k L] Freg Internet resource, and Windows will open it For you,
Windows Task Ba =% Documents v
‘ , . iy Se r Open: d =
2. Select the ‘Run’ option S Setings open:far I
@ Search 3
3. Type “cmd” in the field & Help

provided.
P Shut Down...

4. Click [OK] button | =88 ol ] Gex. i

To telnet: Once the Command Window opens, type the telnet command with the target (DVR) IP Address
and Port ID. Syntax is important, so type one space between command and parameters. Type “telnet
nn.nnn.nnn.nnn pppp”; where “n” stands for the numeric characters in the IP Address and “p” stands
for the numeric characters in the port ID. If you prefer using HyperTerminal to telnet, see Appendix C.

AWINNTAspstem32hcmd. exe =] FS

Microsoft Windows 28860 [Uersion 5.88.21951
C(C> Copyright 1?85-2000 Microsoft Corp.

C:wWINNT“Profilesscrobertsz>telnet bhl.111.141.138

type one space

3,

Example 1 shows a reply. Example 2 shows that the target port ID Address is not able to reply.

Example 1 - telnet with NO Conflict — good connection
AWINNTAsystem32hcmd exe - telnet 63.122 126.130 6808

Example 2 - telnet with conflict — failed to connect

AWINNTAsystemdZicmd. exe

Microsoft Windows 28860 [Uersion 5.88.21951
C(C> Copyright 1?85-2000 Microsoft Corp.

C:wWINNT~Prof iles~croberts>telnet 61.111.141.138 oBA8

Connecting To 61.111.141.138...Could not open a connection to host on port GBAS
: Connect failed

C:sWINNT~Profilesscrobherts
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Appendix D: Telnet DVR from HyperTerminal

Follow these instructions to telnet the Port ID using HyperTerminal from the System Galaxy
PC/Workstation. This verifies whether the Galaxy PC can call the listening port at the DVR Unit.

From the Windows Task Bar:

1. CIle the [Start] button and Select the menu path Eriter a name and chaose an icon far the connection:
“Programs > Accessories > Communications > ﬁ‘l“;f
HyperTerminal”.

lcan:

2. When the ‘Connection Description’ window opens,
enter a name for you connection (in our example

we typed “Test”). ok |

3. Click [OK]

In the ‘Connect To’ window:

1. Typein the DVR’s IP Address in the in the [Host

Enter detailz for the host that pou want to call:

address] field.
Host address: |E1.111.141.13(]
2. Typein the Port ID “6808"” in the [Port number] Port number. | 5308
field.
3. Select “TCP/IP Winsock” in the [Connect] field. fe ey T/ ok I
0k I Cancel |

4. Click [OK] to connect.

Example 1 - Good Connection

#g Test - HyperT erminal o ] |
File Edit Miew Cal Transfer Help
D|=| 53]
|
EL2 |
I |
Connected 0:00:07 |Aulo detect |TCPJ‘IP |SCHULL ||3APS |NUM |Eaplure Print echo g

Example 2 — Connection Failed

Hypertomnal B3

@ Unable to connect ko §1.111.141.130 port 6808

Page 45 of 46



Galaxy DVR Quick Guide

Appendix E: Keywords and Terms

Table 2 Document Keywords

Keyword/Term | Description

“associated” or | A door/reader/input that has been configured with a DVR unit and Camera in

“linked” device | its property screen; when the associated device generates and event, a SG
menu option can be selected to retrieve the video feed from that message’s
timestamp.

DVR Client The DVR software that resides on a PC/Workstation and is able to interface

Software with the DVR. Discovery, Rapid-Eye and DVR NAME Products offer a client-
side application.

DVR Server The DVR software that resides on the DVR Unit itself and is used to operate

Software the DVR. Refer to the DVR Product Manuals for installation and operation of
this equipment.

DVR Digital Video Recorder (the physical DVR unit).

DVR Interface | The DVR Interface is the software feature that allows interaction between the
Access Control System and the Video Surveillance System. (GCS DVR
Interface).

GCS Galaxy Control Systems (acronym).

GCS DVR The System Galaxy window that opens from an operator command or alarm

Viewer and allows user to view video.

Communication | Loop Communication Server is the PC that hosts the System Galaxy software

Server or LCS | and communicates with the Loops/Controllers and the System Galaxy
Database for SG 6.x Software.

SG System Galaxy (acronym); Refers to the SG System (its hardware and/or
software).

SG Workstation | A PC that runs to System Galaxy, but is not the LCS or SG Server.

NVR Network DVR Video Recorder — an embedded application that resides on the
network.
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